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1. Introduction
This is a handout about the various resources for searching for information we
have at Bangor library, including the library catalogue, the electronic
journal databases, and the bibliographic databases.
This handout also shows you how to set up an account with Refworks, the
online reference manager bought by the university library and available for
free to university members, and save references to Refworks as you search.
You can access the library catalogue, the electronic resources and Refworks
from the university campus and from home (using a university user name and
password).
Once you have saved your references to Refworks, you can download the
Write-n-Cite tool which enables you to add references into your essays and
dissertations in Microsoft Word, and create formatted reference lists.
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2. Signing up and logging in to Refworks
Go to the Refworks page: http://www.refworks.com/. Click on Login:

Click on Login through your institution (Shibboleth users)

Select Bangor University from the drop down institutions list and click login

Login with your university user name and password

The first time you log in to Refworks, you will need to fill in your: Name, E-mail
Address, Type of User and Area of Focus. Then enter the Code as displayed
and click on Register.
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3. Creating & Sharing Folders
Go to the tabs across the top of the page, and select Folders. Click on
Create New Folder from the drop down menu.

Name your folder and click ok. You can make as many folders as you like.

To share a folder with other people doing similar research, go to the Folders
tab and click on Organize Folders (see above). Select Share Folder:

Select a folder to share and click on Share Folder:

Refworks will enable you to select various options, and name the shared
folder. The most crucial box to tick is Reference Sharing Options at the
bottom of the page. Click Save when done.
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4. The Library Catalogue
Many people use the basic search page , http://library.bangor.ac.uk/search
but this may give a lot of results for searches, e.g. 4455 results for ecology:

By using the advanced search page http://library.bangor.ac.uk/search/X, you
can make your searches more specific: by date, material type, library, etc.
For example, you can change the Limit Search To box to BU (Bangor
University Electronic Resources only, and the Material Type to Journal, to
search for electronic journals on the subject of ecology:
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5. Saving references from the Library Catalogue
If you want to save the reference of a library source, e.g. a book, in Refworks,
open your Refworks account, and click on the Search tab (second from the
left), and then click on Online Catalogue or Database:

Select Bangor University from the list of Online Catalogues and search for
your source, this works better in the Advanced Search than the Quick Search:

When the catalogue has found your source details, just use Import to Folder
to save the information:
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6. Electronic journal databases
The library has over 100 e-journal databases. Each one is a collection of the
electronic journals published by a particular publisher (e.g. Sage, Cambridge).
Some journals databases contain a couple of thousand journals (e.g. Science
Direct), and some only contain a few journals (e.g. Royal Irish Academy).
The library only buys some of the journals in the databases, so there will also
be some articles you are unable to open, as well as many full text articles
which you can open and read online.
The best e-journal databases to use are the large databases which cover
many subject areas: Atypon, Caliber, Cambridge, Informaworld, Ingenta, IOS
Press, JSTOR, MIT Press, Oxford, Palgrave Macmillan, Sage, Science Direct,
Springer, University of Chicago, Wiley-Blackwell, World Scientific Journals
You will find some of these better for your subject area than others, and you
do not need to use them all! As well as the general databases, there are
possibly some specific to your subject area (ask for the list of e-journal
databases by subject to see which).
Access databases by typing the database name into the database name
search box here: http://library.bangor.ac.uk/search~S1/y.

7. Searching and Saving References from Science Direct
Science Direct is a large database with many e-journals for varied subjects.
You can use basic search to search for your keywords, or use the advanced
search and change settings to reduce your results, e.g. ticking subscribed
sources only will search for articles in journals which Bangor buys, and
therefore can be opened, searching within title rather than all fields will narrow
the search, as will ticking the journals box only and reducing the date range:
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Science Direct is a database which directly exports references to Refworks,
which means it is quite easy to save references.
Tick the references you want to save:

Click on export citations at the top of the article list:

Click on Refworks Direct Export, and Export:

If Refworks is not already open on your computer, you will have to login at this
point. Click on View Last Imported Folder to see your references in Refworks:

And save your references into a folder by clicking all in list and put in folder:
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8. Searching and Saving References from Springer
On Springer, search for your keywords, and use the categories on the right
hand side to narrow your search, e.g. to journal articles only:

Click add to marked items to save references:

Click on Marked Items below My Menu on the left hand side:

Click on download this list (the piece of paper symbol):

Click on RIS (a format for exporting references into Refworks):
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Click on save file and ok:

Note the name of the file as it downloads:

In Refworks, click on the References tab and Import:

Set Import Filter to RIS Format, Database to RIS Format, choose a folder to
save the references into, browse for the file and click it, then click Import, and
your references will save into Refworks and into a folder:
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9. Bibliographic databases
The library has some bibliographic databases. Unlike the ejournal databases,
bibliographic databases do not contain full text articles; they instead
search across a large number of sources and give you lists of relevant
articles, books and conference papers for your search.
You can use WebBridge to see whether the library has copies of the articles
listed in e-journal databases, if we do, WebBridge should link through to them.
Two of the biggest databases are CSA (or CSA Illumina) and Web of
Knowledge which search across a variety of subjects.

10. Saving references from CSA databases
Go to this page: http://www.bangor.ac.uk/library/resources/resources.php.en.
Click on CSA in the box on the right hand side of the screen:

CSA contains a range of different subject databases, and you can select to
just search one or more database/s. Click on specific databases to click on
your chosen databases from the list, or select a wider subject area from the
drop down menu:

This page on the CSA website has factsheets about the contents searched by
each database: http://www.csa.com/e_products/databases-collections.php.
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Type in your search words. This example is a search for the term virtual
worlds using 4 databases (for sociology, computing, library science and
psychology).

Tick articles of interest.

Click on save, print, email above the list of references:
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Select the format (short or long, i.e. basic or fuller information), and the
bibliographic (referencing) style, and click on Export to Refworks:

Log in to Refworks, and click on View Last Imported Folder.

Create a new folder, tick the references, select Put in Folder, choose the
folder from the drop down list, and confirm that this action is ok.
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11. Saving references from Web of Knowledge
Go to this page: http://www.bangor.ac.uk/library/resources/resources.php.en.
Click on Web of Knowledge in the box on the right hand side of the screen:

Type a search, e.g. virtual worlds:

Use the General Categories OR the Subject Areas on the left to refine the
subject areas you want to search. Tick your chosen categories, and then click
on Refine (click more options / values for more subjects to choose from):

Tick articles of interest:
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Click Add to Marked List.

Click Marked List.

Click Save to File.

Select Save File and OK. *Note the filename, you will need to know it!

Login to Refworks, click on the References tab, and select Import.
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From the drop down menus, choose Prifysgol Bangor University, Web of
Knowlegde, and your folder of choice (virtual worlds).

Click on browse, go to desktop, and click on savedrecs.txt.

Click Import.

Click View Last Imported Folder, and there are your saved references.
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12. Manually adding references
If you have a book, journal article or other source of information which you
would like to add to one of your folders of references, click on the References
tab, and choose Add New Reference.

You can use the drop down menu beside view fields used by to choose to
enter your information only using fields used by particular referencing styles.

Fill in any boxes you wish to use with the information you want to save, and
then click on Save Reference:
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13. Searching for your references in Refworks
As well as finding your references by looking in the folders you stored them in,
you can also use the fairly detailed Refworks search function to find
references in all kinds of ways.
Click on the search tab in Refworks:

Click on advanced from the drop down menu, and you can choose from the
search fields provided, which include a lot of categories:

You could search by the title of the reference, or by any number of other fields
including date, publisher, database, etc.

You could use keywords in any abstracts or notes you write for saved
references, to enable findability, e.g. typing “important source” in the abstract
of any particularly useful references, would then enable you, when writing up
your research, to set the search field to abstract and type “important source”,
thereby returning all the references with this phrase.
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14. Installing Write-N-Cite
Write-N-Cite is a tool in Refworks which lets you insert your references into a
document. Once the references have all been inserted, you can use Refworks
to format the document and create your bibliography.
To install Write-N-Cite, go into Refworks, click on the Tools tab, and select
Write-N-Cite from the drop down menu.

Download Write-N-Cite for Windows.

Click on Save File.

The file will download onto your desktop, where you can find and click on it.

The file will then begin installing. Click next several times (unless you want to
change any settings).
N.B. Refworks may already be on your computer. If so, go to the Start
menu, click on All Programs, click on Refworks, and click on Install Write-NCite for Refworks.
If Refworks still will not open in Word, follow the instructions given to enable
macros in the Microsoft Word Trust Center.
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15. Using Write-N-Cite to Create Bibliographies
To open Write-N-Cite, click on the Add-Ins tab (in Microsoft Word 2007), and
then click on Write-N-Cite to open the inset box.

You will need to login to Refworks through the Write-N-Cite box (you will need
to scroll down inside the box a little to click Login through your institution).

Once logged in, your saved references will be available in the box, and can be
added as you write. Just click the point in the text where you want to insert a
reference, and click cite in Write-N-Cite next to the relevant reference.

Once you have inserted all your links, the essay will look something like this:
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To create a bibliography, click on Bibliography in the top tabs in Write-N-Cite.

Select your referencing style from the output style menu (e.g. Harvard), and
click Create Bibliography.

And, as if by magic, you have a full bibliography below your essay, and the
citations have been put in tidily in the text.

If you have any questions about Refworks, or would like to book a
training session, please contact: v.zarach@bangor.ac.uk.

